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Einleitung
Der Begriff „Maya“ kommt aus dem Sanskrit und bedeutet Illu-
sion. Die 3D-Modellierungssoftware Maya ist ursprünglich auf 
fotorealitische Animationen spezialisiert gewesen. Sie wurde kon-
stant weiterentwickelt, sodass sie nun für jede Art von Animation 
verwendet werden kann.

Dieses Skript dient dazu, die Grundlagen des 3D-Modellierens  
und Animierens mit Maya zu verdeutlichen. Die erworbenen Fä-
higkeiten sind auf die meisten 3D-Programme anwendbar. 

Die einfachste Art und Weise Maya zu lernen ist mit dem Pro-
gramm herumzuspielen und auf Entdeckungsreise zu gehen.

„Remember to play, it‘s the best way to learn“ Bert Monroy

Überblick des Skripts
Zuerst beschäftigt sich das Skript mit den Grundlagen des Maya 
Userinterfaces. 

Die darauf folgenden Kapitel sind gemäß dem Arbeitsprozess 
aufgebaut: Modellieren, Rendern, Animieren. Da Maya ein no-
debasiertes System ist, kann man die Arbeitsschritte aber auch 
nach belieben in der Reihenfolge ändern. 

Beim „Modelling“ werden die Modellier-Techniken NURBS 

Wireframe View

Lambert Default Shading

Direct Illumination
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und Polygon zum Erstellen von Objekten genauer betrachtet. Lichter und Schatten, sowie Mate-
rialeigenschaften werden beim anschließenden „Rendering“ zugewiesen. Hierfür wird primär die 
Render Engine „Mental Ray“ verwendet. Die Objekte können nun animiert werden. Dies geschieht 
entweder mithilfe von manuell gesetzten Keyframes oder mit einer physikalischen Simulation. 

Geschichte von Maya
Maya ist durch eine Kombination der drei Softwarelinien „Wavefront - Advanced Visualizer“, 
„Thomson Digital Image - Explore“ und „Alias - Power Animator“ entstanden. Mit diesen ur-
sprünglichen Softwarepaketen wurden fotorealistische Bilder erzeugt wie z.B. die Special Effects 
von “Terminator 2”(James Cameron, 1991) oder “Jurassic Park” 
(Steven Spielberg, 1993). 

Während der Entwicklung von Maya 1.0 (1999) hat das Produk-
tionsteam mit dem Animierer Chris Landreth zusammengear-
beitet. Er hatte mit der Beta-Version den ersten Kurzfilm “Bingo” 
(1998) gemacht. Kurz darauf wurde Maya für die Animationen 
in “The Matrix” (Wachowski-Brothers, 1999) und in “The Mum-
my” (Stephen Sommers, 1999) verwendet. In “The Matrix” wur-
den dabei primär die “Sentinels” Roboter mit mehreren Armen, 
animiert, in “The Mummy” sind die tausenden von Skarabäen als 
Partikelsystem simuliert worden.

Dies führte dazu, dass “Industrial Light and Magic” (ILM) Maya 
als Standard für die Special Effects Industrie einführte. Derzeit 
hat Maya ca. 42% Marktanteil. An zweiter Stelle kommt 3DS-
Max mit 40% Marktanteil (Stand April 2010, 3500 Teilnehmer 
an der Studie). Animationshäuser bevorzugen Maya wegen sei-
ner einfachen Erweiterbarkeit. Es verfügt eine Python- und C++ 
Schnittstelle und bietet eine eigene Skriptsprache MEL. Seit der 
2011 Version ist Maya im QT-Framework geschrieben und kann 
auch um QT-Widgets erweitert werden. 

Der heutige Anwendungsbereich von Maya ist nicht auf die Ani-
mation in Filmen beschränkt, sondern erstreckt sich auch über 
die Entwicklung von 3D-Objekten für Computerspiele, Archi-
tekturvisualisierung und Physiksimulationen.

“The Matrix” - Sentinel

“The Mummy” - Scarabs

“Terminator 2” - Morphing
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Schreibweisen in diesem Skript
Manche Schreibweisen sind durchgehend in dem Skript zu finden und werden hier erläutert.

Zwar ist Maya für eine Vielzahl von Betriebssystemen ausgelegt, jedoch sind die jeweiligen Ober-
flächen identisch.

Die Auswahl eines Menüpunkts wird wie folgt dargestellt:

 - Menü > Befehl (wie z.B. File > New Scene)

Wenn die spezifischen Konfigurationseinstellungen eines Menüpunkts benutzt werden sollen:

 - Menü > Befehl q  (wie z.B. Create > NURBS Primitives Cube q)

Maus- und Tastaturbefehle werden in dieser SCHRIFTART angezeigt.

 - RMB - Rechte Maus Taste (right mouse button)

 - LMB - Linke Maus Taste (left mouse button)

 - MMB - Mittlere Maus Taste (middle mouse button)

Installationshinweise
Unter Windows Vista/7 muss man die Installation als Administrator ausführen. Darüberhinaus 
muss die UAC (User Account Control) deaktivieren damit die Installation erfolgreich ausgeführt 
werden kann.

Auf Windows Systemen sollte man vor dem ersten Starten von Maya sicherstellen, dass eine aktuelle 
Version von DirectX installiert ist. Diese lässt sich auf der Microsoft DirectX Webseite herunterla-
den (http://www.microsoft.com/windows/directx/).
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Weiterführende Literatur

Getting Started Manual
Das offizielle Einsteiger-Handbuch stellt viele grundlegenden Funktionen von Maya vor.

http://usa.autodesk.com/adsk/servlet/index?siteID=123112&id=9502844&linkID=9242256

Maya Dokumentation
Bei der Installation von Maya lässt sich optional die Dokumentation mitinstallieren.Das ist sehr zu 
empfehlen, da sie gleichzeitig die Hilfe-Datei von Maya darstellt, äußerst umfangreich ist und sehr 
viele Probleme mit anschaulichen Beispielen erklärt.

Autodesk Area Community

Die Autodesk Area Community hat eine Sammlung von mehreren Tutorials und anderen nütz-
lichen Plugins, wie z.B. die Maya Bonus Tools.

http://area.autodesk.com/

Autodesk Students Community
Für persönliche Zwecke haben Studenten haben die Möglichkeit eine Studentenlizenz von Auto-
desk zu erhalten. 

http://students.autodesk.com/

Maya Station
Der offizielle Blog vom Maya Support Team. Insbesondere wichtig für Maya Updates und Worka-
rounds für existierende Bugs.

http://mayastation.typepad.com

Tuts+ Network
Das Tuts+ Network hat eine Reihe von verschiedenen Websites die sich über viele Medienrelevante 
Themen beschäftigt. Das CGTuts+ beschäftigt sich mit  Maya, 3DSMax, Blender etc. und bietet 
neben Tutorials auch Texturen und andere Resourcen.

http://cg.tutsplus.com/

CG Society - Society of Digital Artists
Eine recht umfangreiche Website mit Forenbereich und vielen interessanten Informationen über die 
aktuellen Neuigkeiten in der CG-Szene.

http://www.cgsociety.org/

Maya Tutorial Sammlung: http://forums.cgsociety.org/showthread.php?threadid=6360

My Mental Ray
Shader und Materialien für Mental Ray zum Herunterladen und viele Informationen wie man 
Mental Ray richtig einsetzt.

http://www.mymentalray.com/
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Grundlagen
„Without having a goal it is difficult to score.“ Paul Arden

Warum sind wir hier?
Die Frage ist zwar hoch philosophisch und nicht in einigen Sätzen zu beantworten, im Rahmen 
von dem Skript sind wir jedoch hier um gute Animationen zu machen.

Dann stellt sich die Frage: „Was sind denn gute Animationen?“ Eine gute Animation muss emo-
tional ansprechen. Daher erzählt sie meistens eine gute Geschichte, nur Bildern und ohne Worte. 
Gleichzeitig achtet man auch darauf, dass der technische Teil dazu harmoniert und es dann eine 
schöne Animation wird.

Somit stellt sich die Frage: „Was ist eine gute Geschichte?“ Das ist einfach zu beantworten, denn 
eine gute Geschichte baut auf einer guten Idee auf.

Daher sollte man sich immer im Vorfeld einige Gedanken machen was man denn erzählen möchte 
und ob die Idee die man verfolgt auch tatsächlich gut ist. Sobald man eine gute Idee hat, kann man 
auf das Ziel hinarbeiten diese Idee zu verwirklichen.

Wie bekommt man gute Ideen?
„An idea is nothing more nor less than a new combination of old elements.“ James Webb Young

James Webb Young hat 1940, das Buch „A Technique for Producing Ideas“ veröffentlicht. Im Prin-
zip hat er eine kurze Formel beschrieben wie man eine gute Idee erhalten kann.

1. Informationen sammeln: Bereits hier scheitern die meisten. Man braucht viele verschie-
dene Informationen über viele verschiedene Themen. Man muss einerseits viele allgemeine aber 
andererseits auch viele spezielle Informationen sammeln. Dieser Prozess sollte das ganze Leben 
lang anhalten. Je mehr Wissen man ansammelt, desto einfacher ist es neue Verbindungen zwi-
schen bekannten Elementen aufzubauen.

2. Informationen verdauen: Hat man alle Informationen auf ihre Nützlichkeit überprüft, 
versucht man nun sie miteinander zu kombinieren. In diesem Schritt sollte man jede Teilidee die 
einem einfällt aufschreiben.

3. Abstand nehmen: Die meisten Ideen sind nicht beim Nachdenken über die Informationen 
gekommen, sondern sie kommen einfach beim Duschen, oder irgend einer anderen alltäglichen 
Aktivität. Sofern man genügend Informationen bearbeitet hat, arbeitet das Unterbewusstsein ein-
fach weiter an der Idee. Daher kann man Abstand nehmen und etwas anderes machen.

4. Der Eureka Moment: Irgendwann taucht dann einfach eine Idee aus dem nichts auf. 
Wenn nicht einfach weiter Ideen aufschreiben und Informationen sammeln.

5. Die Idee verfeinern: Eine frisch geborene Idee, ist noch grob und unspezifisch, muss jetzt  
noch bearbeitet und geformt werden bzw. spezifiziert.

6. Die Idee mit anderen teilen: WDurch Austausch mit anderen Menschen verbessert sich 
die Idee automatisch. Je mehr man von seinem Wissen und Ideen weitergibt, desto mehr kommt 
von der Welt zurück.

7. Von vorne anfangen: Alles was man gelernt hat durch diesen Prozess einfach dem ersten 
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Schritt hinzufügen und von neuem anfangen. Mit dem bisher gesammelten Wissen über die Hür-
den und Schwierigkeit des Problems, lässt sich die Idee noch weiter verbessern.

Von der Idee zur Animation
1.  Pre-Production: Mit Skizzen und einem Storyboard wird die Animation festgelegt. 

2. Modeling: Mit den Skizzen werden die einzelnen Objekte modelliert. 

3. Texturing: Dem Objekt (Modell) werden die Materialien und Texturen hinzugefügt.

4. Animation: Das Modell wird entweder durch Keyframes animiert oder durch Zuweisung  
  physikalischer Eigenschaften. 

5. Lighting: Es werden Lichter und Schatten in die Szene gesetzt.

6. Rendering:  Aus dem nun fertigen Modell werden die resultierenden Bilder erzeugt.

7. Post-Production: Die fertigen Bilder utnerlaufen Farbkorekturen (Color Grading) und 
ggf. eine abschließende Komposition.

Umsetzung einer Idee in Maya
Abgesehen von Pre- und Post-Production ist jeder Arbeitsschritt in Maya mithilfe von Modulen 
realisiert. Diese Modularisierung wird durch das Node-Konzept von Maya unterstützt, d.h. jedes 
Objekt ist ein Node und hat Ein- und Ausgabeverbindungen zu anderen Nodes. Daher können z.B. 
Modell und Materialien unabhängig voneinander erstellt und erst im finalen Schritt durch Verbin-
den der Nodes zusammengeführt werden. Dies ermöglicht flexible Workflows.

Pre-Production
Im Pre-Production Schritt arbeitet man mit „Storyboards“ und „Layouts“. Enthält die Animation 
Charaktere, fertigt man auch sogenannte „Model Sheets“ an. 

Storyboard
Die beste Art und Weise ein Storyboard anzufertigen, ist weiterhin mit Papier und Stift. Es eignen 
sich schon sehr grobe Konzeptzeichnungen, um den späteren Inhalt der Szenen darzustellen. Das 
Storyboard zieht sich dann bei der Umsetzung wie ein roter Faden durch alle Produktionsschritte.

Storyboards können auch in einfache Animatics (Stop-Motion Clips) umgewandelt werden um ein 
Gefühl zu bekommen ob die Szenen zeitlich zueinander passen.

Layouts
Ist das Storyboard fertig und entspricht die Umsetzungen den eigenen Vorstellungen, versucht man 
das Layout der einzelnen Umgebungen festzulegen, z.B. das Aussehen der gesamten Umgebung 
aber auch Details wie die Art der Kostüme von Charakteren.

Model Sheet
Für die Charaktere werden Model Sheets angelegt um ein klareres Bild vom Aussehen der Welt und 
der Charaktere sowie deren möglicher Bewegungen machen zu können. Dies sind wichtige Vor-
überlegungen damit man weiss wie man den Charakter zu bauen hat und wie flexibel er sein muss.

Hauptsache man hat einen Überblick über das gesamte Projekt. Man kann nicht ohne Storyboards 
arbeiten, Layouts und Modelsheets sind gute Hilfsmittel.
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Arbeiten im 3D-Raum
Die Arbeit im 3D-Raum ist vergleichbar mit dem Umgang einer Kamera in der Realität. Durch 
die Kamera sieht man  nur einen  bestimmten Ausschnitt aus der Welt. Wenn man ein Objekt aus 
verschiedenen Blickwinkeln betrachten will, so muss man die Kameraposition verändern. Bedingt 
durch den Öffungswinkel treten Verzerrungen auf.  

Die perspektivische Kamera hat eine 35mm Öffnung was  der normalen Wahrnehmung entspricht 
(perspektivische Ansicht).

Eine alternative Darstellung im 3D-Raum ist die orthografische Ansicht - entspricht z.B. Blaupau-
sen - wo alle Projektionsstrahlen parallel zueinander sind. In Maya entspricht das der Top, Side und 
Front View.

Eine Besonderheit von 3D-Programmen ist, dass die Kamera nicht Objekte anzeigt die zu nah oder 
zu weit entfernt von ihr sind. Dies verhindert unnötiges Berechnen von Objekten, die kaum sicht-
bar sind bzw. das gesamte Bild einnehmen würden. Das wird mit der “Near Clip Plane” und der 
“Far Clip Plane” ermöglicht. Nur Objekte innerhalb dieser Ebenen werden angezeigt, alle anderen 
werden ignoriert.

Koordinatensystem
Viele 3D-Programme benutzen ein (X, Y, Z) Koordinatensystem. Der Ursprung liegt im Punkt 
(0,0,0).

Die Startperspektive von Maya zeigt ein kleines Koordinatengitter (Grid) welches die XZ-Ebene 
repräsentiert. Die positiven Y-Werte sind über der XZ-Ebene. 

Oben links: Top-View, Oben rechts: Perspective-View Unten links: Front-View, 

Unten rechts: Side-View
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Die Standard Manipulatoren

In Maya werden die Achsen durchgehend im gleichen Farbschema dargestellt: Rot für X, Grün für 
Y und Blau für Z.

Maya Basic User Interface
Um mit Maya zu arbeiten benötigt man eine 3-Tasten Maus. Viele Funktionen des Programms las-
sen sich nur durch die 3. Maustaste nutzen, beispielsweise für das Navigieren innerhalb einer Szene.

Maya Workspace

Als Standardansicht wird ein Panel mit der Kameraansicht “Perspective” (kurz persp) angezeigt.

Panels
Jedes Panel hat sein eigenes Panel Menü sowie eine Leiste mit Anzeigeoptionen. In einem Panel 
wird standardmäßig die “Camera View Type” eingeblendet, sowie ein “Axis Direction Indicator”.

Dieses Panel hat den Titel “persp”, da man auf die Szene durch die perspektivische Kamera blickt.

Der Ursprung (Origin) des Koordinatensystems in einem Grid befindet sich in dem Schnittpunkt 
der beiden schwarzen Linien. Alle Werte in Maya werden relativ zu diesem Punkt errechnet.
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Menu Bar
Die Funktionen von Maya sind gegliedert in mehrere Menusets : Animation (F2), Polygons (F3), 
Surfaces (F4), Dynamics (F5), Rendering (F6), nDynamics (F7). 

Wenn man die Menu Sets wechselt, so ändern sich auch manche Menüeinträge. Falls man einen 
bestimmten Menüpunkt nicht finden kann, sollte man überprüfen ob man sich im richtigen Menu 
Set befindet.

Status Line

Die Status Line ist in mehrere Elemente aufgeteilt:

Menu Set Dropdown - zeigt das aktuelle Menu Set an und ermöglicht den Wechsel in andere Menu 
Sets.

File System Icons  - New Scene, Open File, Save File

Selection Set (per default ausgeblendet) - eine Kontrolle für die gerade aktive Selektionsart.

Selection Mode Icons - verändert das allgemeine Selektierverfahren.

Selection Mask Icons - lassen den ausgewählten Selektionsmodus noch genauer bestimmen.

Snapping Icons - ermöglichen, dass Objekte an Objekten/Komponenten einschnappen.

Rendering Icons - die grundlegenden Renderingtools und -einstellungen.

Select Field - ermöglicht eine genaue Transformation des gerade selektierten Objekts.

Modul-Selector

Anmerkung: Alle Menüs ha-
ben die Eigenschaft, dass man 
sie als Tearoff Menü, also als 
kleines eigenständiges Fenster 
benutzen kann. Diese Menüs 
bleiben bestehen auch wenn 
man die Menu Sets wechselt. 
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Anmerkung: Man kann unerwünschte Teile der Status Line ausblenden indem man auf die 
kleine Linie vor den Icons klickt. 
 
 
 Ausgeklappte Icons Eingeklappte Icons

Shelf
Die Shelf wird verwendet um schnell an Tools zu gelangen. Mit einem einzigen LMB Klick wird 
ein Befehl ausgeführt. Möchte man neben den Standardbuttons noch seine eigenen Menübefehle 
hinzufügen, so drückt man STRG+SHIFT und klickt mit der linken Maustaste auf den entspre-
chenden Menübefehl. Der Befehl wird nicht ausgeführt, aber es wird ein neues Icon in dem gerade 
aktiven Shelftab hinzugefügt.

Channel Box / Layer Editor
Im Channel Box werden die typischen keyable Eigenschaften 
eines selektierten Objekts aufgelistet; diese Werte werden per Ta-
statureingabe verändert. Selektiert man mehrere Felder gleichzei-
tig, kann man mehrere Werte simultan auf den gleichen Wert 
setzen. Im unteren Bereich INPUT sieht man die Konstruktions-
Nodes des Objekts.

Der Layer Editor lässt Objekte verschiedenen Layern zuordnen. 
Mit einer Display-Layer lässt sich die Sichtbarkeit von Objekten 
verändern. Mit einer Render-Layer verändert man das Verhalten 
der Renderengine für die selektierten Objekte und mit Anima-
tions-Layern kann man die Animationen in Ebenen aufteilen.

Time Slider
Der Time Slider ist eine Zeitline mit der man zu bestimmten Frames sprin-
gen kann (LMB auf die Leiste oder manuelle Eingabe im Feld neben der Leiste).  
Existiert ein Keyframe so wird das mit einem roten Strich angezeigt; durch selektieren und ge-
drückthalten von MMB kann man diesen verschieben. Am Ende der Leiste sind die Playback Con-
trols um die  Frames abzuspielen.

Range Slider
Mit dem Range Slider manipuliert man die Zoomstufe des Time Sliders. Mit den Zahleneingaben 
kann man auch die maximale Anzahl der Frames verändern. Der Schlüssel am Ende der Bar ist der 
Auto-Keyframe Toggle - wenn aktiviert, fügt er animierten Objekten automatisch neue Keyframes 
zu wenn sie in einem Frame verändert werden.

ChannelBox/ Layer Editor

Curves Shelf

Time Slider

Range Slider
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Command Line
Hier kann man direkt MEL oder Python Befehle eingeben. Auf der rechten Seite sieht man den 
Konsolen-Output. Falls irgendeine Operation fehlgeschlagen ist so wird der Untergrund der Kon-
sole rot. 

Am Ende der Zeile ist ein Button um den Skript Editor zu öffnen, der alle bisher ausgeführten Be-
fehle auflistet. Klickt man auf die Buchstaben MEL am Anfang der Zeile verändert sich der Modus 
in Python-Eingabe.

Toolbox

Die Toolbox hat alle grundlegenden Manipulationswerkzeuge, wegen den zugehörigen Keyboards-
hortcuts auch QWERTY-Tools genannt (siehe Bild).

Der untere Teil  ist zwischen verschiedenen Panel-Views zu wechseln. Ein Panel-View kombiniert 
mehrere Fenster um effizienter verschiedene Workflows durchzuführen. Es sind einige vorgefertigte 
Views in Maya bereits vorhanden man kann aber auch seine eigenen Views erstellen.

Help Line
Die Statusbar zeigt immer an, welches Werkzeug man gerade selektiert hat. Bei komplexeren Werk-
zeugen, wie das “Birail+”-Tool, steht neben dem Namen auch eine detaillierte Anleitung zu dem 
jeweiligen Tool.

ToolBox

Command Line

Help Line
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Marking Menus
Innerhalb von Maya gibt es viele Marking Menus. Im Prinzip 
hält man die RMB fest und zieht die Maus in die Richtung des 
Befehls den man benutzen möchte und lässt dann wieder die Ta-
ste los.

Marking Menus sind kontextabhängig. RMB auf einem Objekt 
lässt die Darstellungweise ändern, wohingegen im leeren Raum 
RMB ein Selections Menü öffnet.

Zusätzlich gibt es dann noch Tastenmodifier. Zum Beispiel lässt 
sich mit  RMB + H ein Marking Menu öffnen mit dem man 
schnell das aktive Menu Set wechseln kann. 

Keyboard Shortcuts
Um mit Maya zu arbeiten muss man Keyboard-Shortcuts beherrschen. Die am meisten benutzten  
Shortcuts sind ALT gedrückt halten mit einer gedrückten Maustaste um die Kamera zu steuern 
und LEERTASTE kurz drücken um von der aktuellen Ansicht in die vorhergehende Ansicht zu 
wechseln (dabei muss ein Panel aktiv selektiert sein). 

Camera Controls
Um sich im 3D-Raum zu bewegen, gibt es vier Möglichkeiten:

1. Tumble (Kamera Rotieren): ALT + LMB

2. Dolly (Kamera Position rein oder raus bewegen): ALT + RMB

3. Track (Kamera auf einer Schiene bewegen): ALT + MMB

4. Zoom: Mit dem Mausrad scrollen

Um zu einer bestimmten Stelle hinzuzoomen kann man auch STRG + ALT + LMB gedrückt 
halten und macht eine Selektion von oben nach unten um auf die Selektion hereinzuzoomen oder 
von unten nach oben um herauszuzoomen.

Anmerkung: Möchte man eine Übersicht über die gesamte Szene haben, so drückt man A und 
die Kamera zoomt zu einer Übersicht. Hat man etwas selektiert z.B. mit dem Select Tool (Q) , so 
kann man F drücken und die Kamera fokussiert auf die Selektion. (Mit SHIFT-F und SHIFT-
A werden in allen Ansichten simultan die Kameras angepasst - z.B. wenn man gerade in der Four 
View arbeitet.)

Hotbox
Hält man die LEERTASTE länger gedrückt so erhält man die Hotbox. Diese enthält genau die 
gleichen Befehle wie die Menubar, nur dass man nicht mit der Maus den langen Weg zum oberen 
Rand des Bildschirms machen muss.

Darüberhinaus ist das Menü in Zonen eingeteilt, in denen man mit der RMB Marking Menus öff-
nen kann. Das nützlichste Menü findet man direkt auf dem Maya Button in der Mitte der Hotbox. 

RMB auf einer NURBS Sphere und das 

dazugehöringe Marking Menu
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Mit diesem Menü kann man schnell das aktive Panel in ein default Camera Panel (persp, top, side, 
front) wechseln.

Anmerkung: Die Hotbox kann man umstellen, das Menü vom aktiven Modul angezeigt werden. 
Hierfür öffnet man die Hotbox (LEERTASTE) und LMB auf Hotbox Controls, wählt aus dem 
Menü das gerade aktive Modul aus und wählt den Befehl „Show only <aktives Modul>“.

Displayeigenschaften des ViewPanels
In ViewPanels kann man mit 1(geringe Qualität), 2(mittlere Qualität), 3(hohe Qualität) die Dis-
playqualität des selektierten NURBS-Objekts verändern - dies hat keinen Einfluss auf das spätere 
Rendern. Es ist nur dazu da um schnellere Previews zu erhalten.

Hingegen bei Polygon-Objekten wird beim Benutzen der Taste 2 (Smoothing with Polycage), oder 
3 (Smoothing without Polycage) ein Smoothing angewendet. Dies hat Einfluss auf das spätere 
Rendern. Mit 1 kann man den ursprünglichen Zustand wiederherstellen.

4 - der Wireframe Modus

5 - der Shader Modus 

6 - der Shader Modus mit Texturen

7 - der Shader Modus mit Texturen und Licht

Hotbox

Wireframe Shader Shader mit Texturen
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Die Wichtigsten Shortcuts im Überblick
Die QWERTY-Tools, (Q Select Tool, W Move Tool, E Rotate Tool, R Scale Tool, T Show Mani-
pulator, Y Last Tool Used) sind wohl die am häufigsten benutzten Tools in Maya. Die Tastatur-
kürzel sind  gleichbleibend über das gesamte Programm und können in vielen Interaktionsfenstern 
benutzt werden.

General
Q Select
W Move Tool
E Rotate Tool
R Scale Tool
T Show Manipulator Tool
Y Last Used Tool

Z Undo
SHIFT – Z Repeat

D Toggle Edit Pivot Point (nur mit Move,Rotate, Scale)
INS Edit Pivot Point

STRG-D Duplicate
STRG-SHIFT-D Duplicate Special

SHIFT-D Duplicate with previous Transform

Camera
ALT + LMB Tumble (rotieren)
ALT + RMB Dolly (Zoomen)
ALT + MMB Track 

Snapping
X Toggle Grid Snapping
C Toggle Curve Snapping
V Toggle Point Snapping

Animation
SHIFT-W Transform Keyframe (XYZ)
SHIFT-E Rotate Keyframe(XYZ)
SHIFT-R Scale Keyframe (XYZ)

S Key All (Keyframe für Transform, Rotate, Scale)
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Arbeiten mit Nodes
In Maya wird jedes Element (Kurven,  Polygon-Objekte, Texturen, etc.)  intern als einzelnes Node 
repräsentiert oder als Serie von verbundenen Nodes.

Als Beispiel: Eine neu erzeugte Nurbs-Sphere hat drei Nodes:

1. Transform Node: Hier sind alle Translationen, Rotationen und Skalierungen gespeichert.

2. Shape Node: In diesem Node sind alle Eigenschafften gespeichert wie das Objekt aussieht.

3. Input Node:  Verwaltet alle Eigenschaften wie die Geometrie erzeugt wurde.

4. Shading Node: Verwaltet die Eigenschaften für das Objekt wenn es ausgerendert wird.

Anmerkung: Beim Duplizieren (STRG-D) eines Objekts werden nicht die Input Nodes dupliziert

Viele Nodes werden automatisch erzeugt. Man kann sich die Nodes visualisieren lassen im Hyper-
graph. Shadernodes werden im Hypershade visualisiert. (Siehe „Hypershade Editor“ Seite 75) Um 
Werte von Nodes zu verändern benutzt man den Attribute Editor oder die Channel Box. 

Hypergraph
Der Hypergraph lässt sich in zwei Modi ausführen (Am Beispiel 
einer erzeugten NURBS-Sphere)

Hierarchy
In diesem Modus wird die Hierarchie der Szene dargestellt,  sich 
alle Objekte der Szene und dessen Relation zueinander. Es wer-
den allso alle Eltern Kind Beziehungen graphisch dargestellt. 

Connections
Man muss zunächst ein Objekt auswählen um dann den Hypergraph Connections zu öffnen. Hier 
sieht man für ein einzelnes Objekt wie es mit anderen Nodes verknüpft ist. Man kann hier auch 
„hereinzoomen“ auf einzelne Objekte und die weiteren Connections der einzelnen Nodes sehen. 

Hier am Beispiel von einer NURBS-Sphere, hat man die Nodes: „makeNurbsSphere1“ (Input 
Node), „nurbsSphereShape1“ (Shape Node), „initalShadingGroup“ (Shading Node) und „nurbs-
Sphere1“ (Transform Node)

Mit RMB auf den einzelnen Nodes lassen sich die Verbindungen zwischen verschiedenen Nodes 
erstellen. Mit Del lassen sich Nodes löschen.

Hypergraph Hierarchy

Hypergraph Connections
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Attribute Editor
Öffnet man den Attribute Editor findet man die gleichen vier Nodes, wie im Hypergraph Connec-
tions Editor. Hier sind alle Einstellungsmöglichkeiten um die einzelnen Nodes. Zusätzlich lassen 
sich hier für viele Eigenschaften Keys für Animationen setzen. Jedem Node lässt sich beliebig um-
benennen und mit einem Kommentar versehen. 

Anmerkung: Es bietet sich an den Attribute Editor (STRG-A) als eigenes Fenster zu benutzen an-
statt immer den ChannelBox Editor auszutauschen. Unter Window>Settings and Preferences> 
Preferences (linkes Menü) Interface muss man hierfür bei “Open Attribute Editor:” die Option 
“open in seperate window” auswählen.

Der Attribute Editor
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Tipps zu Einstellungen der Maya UI
Unter Window>Settings and Preferences> Preferences (im folgenden abgekürzt mit Prefe-
rences) lassen sich die meisten Einstellungen vornehmen.

Infinite Undo/Redo aktivieren
Undo (Z) und Redo (SHIFT-Z) sind standartmäßig limitiert zu 50 Undo-Steps. 

Dies lässt sich ändern unter Preferences - (Settings) - Undo. Dort setzt man die Queue auf Infinite 
oder einen beliebigen Wert.

Autosave aktivieren
Neu eingeführt mit Maya 2011 ist eine Autosave feature. Da Maya oftmals bei komplexen berech-
nungen abstürzt ist es sehr sinnvoll das Autosave feature zu aktivieren.  Unter Preferences - (Set-
tings) - Files/Projects bei dem Punkt Autosave ein Häckchen setzen bei Enable.

View Cube deaktivieren
Der Viewcube verleitet dazu das man nur die Maus verwendet und immer nur in einem Panel ar-
beitet anstatt sich mit den Tastaturkürzeln auseinanderzusetzen. 

Daher sollte man den ViewCube deaktivieren indem man unter Preferences - (Interface) - Viewcu-
be das Häckchen bei „Show View Cube“ entfernt.

Interactive Creation deaktivieren
Interactive Creation erlaubt es interaktiv eine Geometrie in ein Viewport zu erzeugen. Jedoch wei-
chen unter Umständen die Eigenschaften von einer direkt erzeugtem Geometrie ab. Außerdem 
ist es in den meisten Fällen einfacher eine Geometrie direkt zu erzeugen und dann sie mit den 
QUERTY-Tools anzupassen.

Alle Beispiele im Skript verwenden keine Interactive Creation. Man deaktiviert Interactive Crea-
tion indem man das Häcken unter Create > NURBS Primitives > Interactive Creation, sowie bei 
Create > Polygon Primitives > Interactive Creation, entfernt.

Hintergrund Gradient deaktivieren
Man kann den Hintergrund Gradient von Panels deaktivieren indem man unter Preferences - 
(Display) - bei „Background gradient“ auf „Off“ umschaltet.


